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คู่มือการใช้งาน Farm1 

• เอาต์พุต Contect 5A/NO 4 ช่อง  

• อินพุตดิจิทัล 2 ช่อง  

• อินพุตแอนะล็อก 2 ช่อง  

• ต่ออุปกรณ์เสริมผ่าน RS485 และ I
2
C 

• ใช้แรงดันไฟฟ้าได้ 5V ถึง 24V 

• ใช้ ESP32 เป็นตัวประมวลผล 

• เช่ือมต่ออินเตอร์เนต็ผ่าน WiFi 

• มีวงจรนับเวลา (RTC) ในตัว 

• ขนาด 110 x 120 x 40 มิลลิเมตร 

 

Farm1 กล่องควบคุมฟาร์มระบบ IoT ใช้ไมโครคอนโทรลเลอร์ ESP32 มาพร้อม WiFi และบลูทูธ ติดตั้ง

บนบอร์ด Farm1 รองรับการต่ออุปกรณ์ภายนอกผ่านช่องเอาต์พุต 5A/220V จำนวน 4 ช่อง ต่อ

อินพุตดิจิทัล 2 ช่อง อินพุตแอนะล็อก 2 ช่อง และ I/O จำนวน 1 ช่อง มีช่องต่อ I2C และ RS485 ใช้งาน

ได้กับเซ็นเซอร์ทุกประเภท มีวงจรนับเวลา (RTC) มาในตัว มาพร้อมกล่องติดตั้งบนรางปีกนก 

 

 

เวอร์ช่ัน รายละเอียดการแก้ไข เผยแพร่ 

1.0 เพ่ิมข้อมูลทั่วไปเกีย่วกับ Farm1 และการเขยีนโปรแกรมสั่งงานเบื้องตน้ 18/11/2564 

1.1 เพ่ิมวิธีการใช้งานกับ HandySense 25/11/2564 

1.2 เปล่ียนเซ็นเซอร์หัวขอ้ HandySense จาก SHT30 เป็น SHT20 8/12/2564 

1.3 เพ่ิมหัวข้อ ตั้งคา่เช่ือมต่อ WiFi ด้วยแอพฯ EspTouch 10/3/2565 

1.4 แก้ไขขั้นตอนอัพโหลดเฟิร์มแวร์ 7/4/2567 
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สารบัญ 

สร้างระบบควบคุมฟาร์ม IoT อยา่งรวดเร็วด้วย HandySense 4 

การต่อเซ็นเซอร์เข้ากบับอร์ด Farm1 4 

การอัพเดทเฟิร์มแวร์ HandySense 6 

การเพ่ิมอุปกรณ์เขา้ระบบ HandySense 9 

ตั้งค่าเช่ือมต่อ WiFi ด้วยแอพฯ EspTouch 15 

ข้อมูลด้านฮาร์ดแวร์และวงจร 17 

คุณสมบตัิทางไฟฟ้า 17 

ตำแหน่งขาตอ่ใช้งาน 18 

การจ่ายไฟ 18 

ช่องเอาต์พุต 20 

ช่องอินพุตดิจิทัล 22 

ช่องอินพุตแอนะล็อก 23 

ช่อง I/O 24 

ช่อง I
2
C 26 

ช่อง RS485 27 

วงจรนับเวลา (RTC) 28 

การเขียนโปรแกรมสั่งงานด้วย Arduino IDE 30 

ติดตั้งโปรแกรม Arduino IDE 30 

ติดตั้งไดร์เวอร์ FT231X 32 

การเพ่ิมบอร์ด ESP32 ลงโปรแกรม Arduino IDE 35 

การเช่ือมตอ่ Farm1 เขา้กับเคร่ืองคอมพิวเตอร์ 37 

ทดสอบอัพโหลดโปรแกรมไฟกระพริบ 37 
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เขียนโปรแกรมสั่งงานช่องเอาต์พุต 40 

เขียนโปรแกรมอ่านช่องอินพุตดิจิทัล 41 

เขียนโปรแกรมอ่านช่องอินพุตแอนะล็อก 42 

เขียนโปรแกรมช่อง I/O อ่านค่าอุณหภูมิจาก DS18B20 44 

เขียนโปรแกรมช่อง I
2
C อ่านค่าอุณหภูมิและความช้ืนจาก SHT30 47 

เขียนโปรแกรมช่อง RS485 อา่นคา่อณุหภมูิและความช้ืนจาก XY-MD02 48 

เขียนโปรแกรมตั้งเวลาและอ่านค่าเวลาจากวงจรนับเวลา (RTC) 49 

คำแนะนำการติดตั้ง 49 

แนวทางการแก้ไขปัญหา 50 
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สร้างระบบควบคุมฟาร์ม IoT อย่างรวดเร็วดว้ย HandySense 

HandySense เป็นแพลตฟอร์มระบบควบคุมฟาร์มประกอบด้วยฮาร์ดแวร์และซอฟแวร์ เปิดเป็น 

Open Source เปิดให้ผู้สนใจนำไปพัฒนาต่อได้ บอร์ด Farm1 สามารถใช้งานร่วมกับระบบ Cloud ของ 

HandySense ผ่านเฟิร์มแวร์ที่ปรับแต่งมาโดยเฉพาะ โดยมีข้อกำหนดสำคัญที่ต้องใช้ฮาร์ดแวร์ เซ็นเซอร์ 

และการต่อสาย ในรูปแบบที่ผู้ผลิตกำหนดเท่านั้น 

การต่อเซ็นเซอร์เข้ากับบอร์ด Farm1 

อุปกรณ์ด้านอิเล็กทรอนิกส์ที่จำเป็นต้องใช้ มีดังนี้  

 1. บอร์ด Farm1 2. เซ็นเซอร์วัดอุณหภูมิและความช้ืน SHT20 

   

 3. เซ็นเซอร์วััดความช้ืนในดิน 4. เซ็นเซอร์วัดแสง (BH1750) 

   

 5.อะแดปเตอร์ 12V 1A หัว DC Jack 
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ต่ออุปกรณ์เข้าด้วยกันดังนี้ 
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การอัพเดทเฟิร์มแวร์ HandySense 

เปิดฝากล่อง Farm1 ออกมา แล้วใช้สาย USB-C เชื ่อมต่อเข้ากับคอมพิวเตอร์ตามหัวข้อ การ

เช่ือมต่อ Farm1 เข้ากับเคร่ืองคอมพิวเตอร์ ติดตั้งไดร์เวอร์ตามหัวข้อ ติดตั้งไดร์เวอร์ FT231X  

ดาวน์โหลดเฟิร์มแวร์ Farm1 เวอร์ชั ่นล่าสุดได้ท ี ่ https://github.com/Farm1-Tech/Farm1-

HandySense-Firmware/releases โดยคลิกเลือกดาวน์โหลดไฟล์ .bin เวอร์ช่ันล่าสุด 

 

จะได้ไฟล์ xxxx.bin มา (ดังรูป) 

 

  

https://github.com/Farm1-Tech/Farm1-HandySense-Firmware/releases
https://github.com/Farm1-Tech/Farm1-HandySense-Firmware/releases
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2) ใช้โปรแกรม esptool.js ในการอัพโหลดเฟิร์มแวร์ (รองรับ Google Chrome เวอร์ช่ันล่าสุด) โดยเข้า

ไปที่ https://espressif.github.io/esptool-js/ แล้วกดปุ่ม Connect เพื่อเริ ่มเชื่อมต่อกับบอร์ด 

Farm1 

 

3) เ ล ื อก  COM port ท ี ่ แสดงข ึ ้ นม า  แล ้ วกด 

เช่ือมต่อ (Connect) 

4) กดปุ่ม Erase Flash ล้างการตั้งค่าเก่าที่อาจจะ

มีก่อนหน้านี ้ เม ื ่อเสร็จแล้วจะมีข้อความ Chip 

erase completed ดังรูป 

 

 

  

https://espressif.github.io/esptool-js/


  กล่องควบคุมฟาร์มระบบ IoT 

  หน้าที่ 8 

5) จากนั้นที่ช่อง Flash Address ใส่ 0x0000 (1) แล้วกดปุ่ม เลือกไฟล์ (Choose) (2) 

 

6) เลือกไฟล์ .bin ที่ได้ดาวน์โหลดมา (1) แล้วกด Open (2) 

 

7) กดปุ่ม Program เพ่ือเร่ิมอัพโหลดเฟิร์มแวร์ สังเกตจะมีแถบบอก % การอัพโหลดแสดงขึ้นมา 

 

8) เมื่ออัพโหลดโปรแกรมเสร็จจะมีข้อความ Leaving... ขึ้น (ดังรูป) 

 

9) ถอดสาย USB ออกแล้วเสียบใหม่ จากนั้นทำขั้นตอนถัดไปได้เลย 
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การเพ่ิมอุปกรณ์เข้าระบบ HandySense 

เข้าไปที่ dashboard.handysense.io จากนั้นสมัครสมาชิก หรือล็อกอินตามขั้นตอน 

 

จากนั้นระบบจะพาเข้ามาหน้าแรก ซ่ึงเป็นหน้าจัดการฟาร์ม กดปุ่ม สร้างฟาร์ม 

◼ HandySense ออกแบบระบบให้ต้องมีฟาร์มก่อน จากนั้นจึงจะเพ่ิมอุปกรณ์ลงในฟาร์มได้ ใน 1 ฟาร์ม 

เพ่ิมได้หลายอุปกรณ์ 

 

ในหน้าต่างสร้างฟาร์ม ให้ตั้งช่ือฟาร์ม (ห้ามมีเว้นวรรค) ใส่รายละเอียด (เว้นว่างได้) จากนั้นกดปุ่ม สร้าง 

https://dashboard.handysense.io/
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ระบบจะพาเข้ามาหน้าฟาร์มที่สร้างอัตโนมัติ ให้กดปุ่ม เพ่ิมอุปกรณ์ เพ่ือเร่ิมเพ่ิมอุปกรณ์ทันที 

 

  



  กล่องควบคุมฟาร์มระบบ IoT 

  หน้าที่ 11 

หน้าต่างสร้างอุปกรณ์จะแสดงขึ้นมา ในขั ้นตอนที ่ 1 เป ็นแจ้งเตือนให้เชื ่อมต่ออุปกรณ์กับเครื่อง

คอมพิวเตอร์ ให้กดปุ่ม สร้างอุปกรณ์ 

 

เลือกพอร์ตของอุปกรณ์ แล้วกดปุ่ม เช่ือมต่อ 
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ขั้นตอนที่ 2 ตั้งค่าการเช่ือมต่อ WiFi ให้อุปกรณ์ แล้วกดปุ่ม ถัดไป 

◼ Farm1 รองรับการเช่ือมต่อ WiFi 2.4GHz เท่านั้น 

◼ ถ้า WiFi ไม่มีรหัสผ่าน ช่องรหัสผ่านให้เว้นว่างไว้ 

 

ขั้นตอนที่ 3 ตั้งช่ือชุดอุปกรณ์ ใส่รายละเอียด (เว้นว่างได้) แล้วกดปุ่ม ถัดไป 
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รอประมวลผล ใช้เวลา 2 – 5 วินาที จะแสดงหน้าขั้นตอนที่ 4 สร้างอุปกรณ์เสร็จสิ้น กดปุ่ม เสร็จสิ้น 

เพ่ือปิดหน้าต่างนี้ 

 

จะมีอุปกรณ์เพ่ิมเข้ามาในฟาร์มแล้ว กดที่กล่องอุปกรณ์เพ่ือดูรายละเอียด และตั้งค่าต่าง ๆ 

 

  



  กล่องควบคุมฟาร์มระบบ IoT 

  หน้าที่ 14 

จากนั้นรอประมาณ 2 นาที (ค่าจากเซ็นเซอร์ส่งขึ้น HandySense ทุก ๆ 2 นาที) ค่าที่วัดได้จาก

เซ็นเซอร์ก็จะแสดงขึ้นมาแล้ว 

 

รายละเอ ียดการใช้งานระบบ ศึกษาเพิ ่มเติมได้จากเอกสาร คู ่ม ือการใช้งาน Web Application: 

HandySense ระบบเกษตรแม่นยำ ฟาร์มอัจฉริยะ  

https://github.com/HandySense/HandySense-Manual/blob/main/HandySense%20Web%20Application%20Manual-PBRS.pdf
https://github.com/HandySense/HandySense-Manual/blob/main/HandySense%20Web%20Application%20Manual-PBRS.pdf
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ต้ังค่าเชื่อมต่อ WiFi ด้วยแอพฯ EspTouch  

การเพ่ิมอุปกรณ์ลง HandySense ที่หน้างานบางคร้ังอาจจะไม่สะดวก วิธีการที่สะดวกกว่าคือการเพ่ิม

อุปกรณ์ลง HandySense และทดสอบให้เรียบร้อย เมื่อนำไปติดตั้งหน้างานจริงจึงค่อยใช้แอพพลิเคช่ัน 

EspTouch เปล่ียนการตั้งค่าการเช่ือมต่อ WiFi เป็นของหน้างาน โดยมีขั้นตอนการเปล่ียนการตั้งค่าดังนี้ 

◼ แอพฯ EspTouch ใช้ได้กับเฟิร์มแวร์ HandySense for Farm1 เวอร์ชั่นล่าสุดเท่านั้น หากใช้เฟร์ิม

แวร์เวอร์ช่ันเก่าแนะนำให้ติดตั้งเฟิร์มแวร์ใหม่ตามหัวข้อ การอัพเดทเฟิร์มแวร์ HandySense ก่อน 

เข้าไปที่ Google Play ค้นหา และติดตั้งแอพพลิเคช่ัน EspTouch ให้เรียบร้อย 

 

ที่กล่อง Farm1 ให้จ่ายไฟ แล้วกดปุ่ม IO0 ค้างไว้ 5 วินาที แล้วปล่อย สังเกตไฟ NET กระพริบเร็วขึ้น 

แสดงว่าเข้าโหมด SmartConfig ซ่ึงสามารถใช้แอพพลิเคช่ัน EspTouch ตั้งค่าได้แล้ว 
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เปิดแอพฯ EspTouch ขึ้นมา ชื่อ WiFi เป็นชื่อเดียวกับชื่อที่โทรศัพท์มือถือเชื่อมต่ออยู่   (1) (หาก

ต้องการเปล่ียน WiFi ให้เปล่ียนการเช่ือมต่อที่โทรศัพท์ก่อน) จากนั้นใส่รหัสผ่านของ WiFi (2) แล้วกด

ปุ่ม CONFIRM (3) 

 

รอแอพฯ ส่งข้อมูลการตั้งค่า WiFi ไปที่กล่อง Farm1 ประมาณ 20 วินาที ถึง 1 นาที 

 

เมื่อตั้งค่าสำเร็จ จะแสดงหมายเลข IP ที่กล่อง Farm1 ได้รับ (ดังรูป) กล่อง Farm1 จะรีบูต และพยาม

เช่ือมต่อ WiFi ใหม่ที่ได้ตั้งค่าไว้ โดยสังเกตไฟ NET กระพริบช้า ๆ แสดงว่ากำลังเช่ือมต่อ WiFi และหาก

ติดค้างแสดงว่าเช่ือมต่อ WiFi ได้แล้ว 

 

เป็นอันจบขั้นตอนการเปล่ียนการตั้งค่า WiFi ด้วยแอพฯ EspTouch  
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ข้อมูลด้านฮาร์ดแวร์และวงจร 

คุณสมบัติทางไฟฟ้า 

คุณสมบตัิ ิ ต่ำสุด ปกต ิ สูงสุด 

แรงดันไฟฟ้า (DC/AC) 5V 12V 24V 

กระแสไฟฟ้า - - 1A 

การทนกระแสไฟฟ้าช่องเอาต์พุต - 5A/220V - 

แรงดันช่องอินพุตดิจิทัล 3V - 12V 

กระแสช่องอินพุตดิจิทัล 0A (LOW) - 3mA (HIGH) 

แรงดันช่องอินพุตแอนะล็อก 0V - 9.9V 

กระแสช่องอินพุตแอนะล็อก - - <1mA 

แรงดันช่อง I/O (D3) 0V - 3.3V 

กระแสช่อง I/O ขณะเป็นอิินพุต 0A (LOW) - 1mA (HIGH) 

กระแสช่อง I/O ขณะเป็นเอาต์พุต 0A - 10mA 

แรงดันช่อง I
2
C - 3.3V - 

แรงดันช่อง VIN แรงดันไฟเข้า – 0.6V 

แบตเตอร่ีวงจรนับเวลา (RTC) 3V (CR2032) 
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ตำแหน่งขาต่อใช้งาน 

 

รูปที่ 1 ตำแหน่งขาต่อใช้งาน Farm1 

การจ่ายไฟ 

รองรับการจ่ายไฟผ่านช่อง DC / เทอมินอลปลั๊ก รองรับไฟเข้าได้ 5V และ 7V ถึง 24V (ขึ้นอยู่

กับจ้ัมเปอร์) ทั้งกระแสตรง (DC) และกระแสสลับ (AC) กระแสไฟฟ้าที่ต้องการต่ำสุด 1A 

จ้ัมเปอร VIN ใช้เลือกระดับแรงดันไฟเข้า โดยหากจ้ัมที่ 5V ต้องจ่ายไฟเข้า 5V เท่านั้น (DC) หาก

เลือกเป็น 7-24V เลือกจ่ายไฟด้วยหม้อแปลง แบตเตอร่ี โซล่าเซลล์ หรือแหล่งจ่ายไฟอื่นที่อยู่ในช่วง 7V 

ถึง 24V ได้ รองรับทั้งไฟฟ้ากระแสตรงและกระแสสลับ 

หลอดแอลอีดี POWER ติดสว่างเป็นสีเขียวเมื่อได้รับไฟฟ้าจากแหล่งจ่ายไฟ 
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รูปที่ 2 วงจรส่วนภาคจ่ายไฟ 

ตัวอย่างการจ่ายไฟให้บอร์ด Farm1 ด้วยสวิทช่ิงเพาเวอร์ซัพพลาย 12V แสดงดังรูปที่ 3 

 

รูปที่ 3 การจ่ายไฟให้บอร์ด Farm1 ด้วยสวิทช่ิงเพาเวอร์ซัพพลาย 12V 
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ตัวอย่างการจ่ายไฟให้บอร์ด Farm1 ด้วยอะแดปเตอร์ 9V แสดงดังรูปที่ 4 

 

รูปที่ 4 การจ่ายไฟให้บอร์ด Farm1 ด้วยอะแดปเตอร์ 9V 

ช่องเอาต์พุต 

ช่องเอาต์พุตประกอบด้วย O1 ถึง O4 เป็นเอาต์พุตแบบหน้าคอนเทครีเลย์ NO ทนกระแสได้สูงสุด 

5A ที่ 220V มีหลอดแอลอีดีแสดงสถานการณ์ทำงาน โดยจะติดสว่างเป็นสีส้มเมื่อหน้าคอนเทคต่อ 

(รีเลย์ทำงาน) 

 

รูปที่ 5 ส่วนประกอบภาคเอาต์พุต 
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ตัวอย่างการต่อช่องเอาต์พุตเข้ากับหลอดไฟและโซลินอยด์วาล์ว แสดงดังรูปที่ 6 

 

รูปที่ 6 การต่อช่องเอาต์พุตเขา้กับหลอดไฟและโซลินอยด์วาล์ว 

◼ การต่อช่องเอาต์พุตเข้ากับอุปกรณ์กำลังสูง ต้องต่อผ่านแมกเนติก (Magnetic Contactor) เท่านั้น 

รีเลย์ของช่องเอาต์พุตต่อเข้ากับ ESP32 ผ่านขา 25, 14, 12 และ 13 ตามลำดับ บล็อกไดอะแกรมส่วน

เอาต์พุตดิจิทัลแสดงดังรูปที่ 7 

 

รูปที่ 7 บล็อกไดอะแกรมส่วนเอาต์พุตดิจิทัล 
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ช่องอินพุตดิจิทัล 

ช่องอินพุตดิจิทัลประกอบด้วย D1 และ D2 รองรับไฟเข้าได้ 3V ถึง 12V คั่นระหว่างสัญญาณเข้า

กับ ESP32 ด้วยออปโต้คัปเปอร์ มีหลอดแอลอีดีสีส้ม ติดเมื่อได้รับลอจิก 1 

 

รูปที่ 8 ส่วนประกอบภาคอินพุตดิจิทัล 

ตัวอย่างการต่อสวิตช์ และลูกลอยเข้ากับช่องอินพุต แสดงดังรูปที่ 9 

 

รูปที่ 9 การตอ่สวิตช์ และลูกลอยเข้ากับช่องอินพุต 
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ช่องอินพุตดิจิทัล เช่ือมต่อกับ ESP32 ผ่านออปโต้คอปเปอร์ที่ขา 34, 35 ตามลำดับ ทำงานแบบ Active 

LOW เมื่อมีสัญญาณอินพุตเข้ามา สัญญาณเข้า ESP32 จะเป็น LOW และหากไม่มีสัญญาณอินพุต

เข้ามา สัญญาณเข้า ESP32 จะเป็น HIGH บล็อกไดอะแกรมส่วนอินพุตดิจิทัล แสดงดังรูปที่ 10 

 

รูปที่ 10 บล็อกไดอะแกรมส่วนอินพุตดิจิทัล 

ช่องอินพุตแอนะล็อก 

ช่องอินพุตแอนะล็อกประกอบด้วย A1 และ A2 รองรับไฟเข้าได้ 0V ถึง 9.9V ใช้ต่อเข้ากับเซ็นเซอร์

ที่ให้เอาต์พุตเป็นแรงดันไฟฟ้า เช่น เซ็นเซอร์วัดความช้ืนในดิน, เซ็นเซอร์วัดระดับน้ำ, เซ็นเซอร์วัดความขุ่น

ของน้ำ, เซ็นเซอร์วัดความเป็นกรด-ด่าง (PH) เป็นต้น 

 

รูปที่ 11 ส่วนประกอบภาคอินพุตแอนะล็อก 
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ตัวอย่างการต่อเซ็นเซอร์วัดความช้ืนในดินเข้ากับช่องอินพุตแอนะล็อก แสดงดังรูปที่ 12 

 

รูปที่ 12 การต่อเซ็นเซอร์วัดความช้ืนในดินเข้ากับช่องอินพุตแอนะล็อก 

อินพุตแอนะล็อกผ่านวงจรบัพเฟอร์จากนั้นเข้าวงจรแบ่งแรงดันเพ่ือให้แรงดันไม่เกิน 3.3V ทำให้ ESP32 

สามารถรับแรงดันสูงได้ ช่องแอนะล็อกต่อกับ ESP32 ขา 36, 39 ตามลำดับ บล็อกไดอะแกรมส่วน

อินพุตแอนะล็อก แสดงดังรูปที่ 12 

 

รูปที่ 13 บล็อกไดอะแกรมส่วนอินพุตแอนะล็อก 

ช่อง I/O 

ช่อง I/O คือ D3 รองรับแรงดันไฟเข้าสูงสุด 3.3V ใช้ต่อกับกับเซ็นเซอร์/อุปกรณ์ภายนอกสื่อสาร

ด้วยสายเส้นเดียว เช่น เซ็นเซอร์วัดอุณหภูมิและความช้ืน DHT11/DHT22, เซ็นเซอร์วัดอุณหภูมิแบบกัน

น้ำ DS18B20, หลอดแอลอีดี RGB เบอร์ WS2812, เซอร์โวมอเตอร์ เป็นต้น 
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รูปที่ 14 ส่วนประกอบภาค I/O 

ตัวอย่างการต่อเซ็นเซอร์วัดอุณหภูมิหัวกันน้ำ DS18B20 เข้ากับช่อง I/O แสดงดังรูปที่ 15 

◼ DS18B20 ทำงานแบบ 1-wire ตามขอ้กำหนด ต้องตอ่ตัวต้านทาน Pull-up ด้วย 

 

รูปที่ 15 การตอ่เซ็นเซอร์วัดอุณหภูมหิัวกันน้ำ DS18B20 เข้ากบัช่อง I/O 

ช่อง I/O ต่อตรงกับ ESP32 ขา 26 คั่นด้วยตัวต้านทาน 100Ω เพื่อป้องกันกระแสไหลเกิน พร้อมตัว

ต้านทาน 4.7 kΩ เป็น Pull-up บล็อกไดอะแกรมส่วน I/O แสดงดังรูปที่ 16 

 

รูปที่ 16 บล็อกไดอะแกรมส่วน I/O 
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ช่อง I
2
C 

ช่อง I
2
C ประกอบด้วย SCL และ SDA ใช้ต่อกับอุปกรณ์ I

2
C เช่น เซ็นเซอร์วัดอุณหภูม ิและ

ความชื้น SHT30, เซ็นเซอร์วัดความกดอากาศ BMP280, เซ็นเซอร์แสง BH1750 เป็นต้น ใช้งานไดก้ับ

อุปกรณ์ที่ใช้แรงดันไฟฟ้า 3.3V มีหลอดแอลอีดีกระพริบบอกสถานะรับ-ส่งข้อมูล 

 

รูปที่ 17 ส่วนประกอบภาค I
2
C 

การต่อกับเซ็นเซอร์ จำเป็นจะต้องต่อขา SCL และ SDA ให้ถูกต้อง ตัวอย่างการต่อเซ็นเซอร์วัดอุณหภูมิ

และความช้ืน SHT20 แสดงดังรูปที่ 18 

 

รูปที่ 18 การต่อเซ็นเซอร์วัดอุณหภมูิและความช้ืน SHT30 เขา้กับช่อง I
2
C 
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ช่อง I2C ต่อตรงกับ ESP32 ขา 22 (SCL), 21 (SDA) โดยมีตัวต้านทาน Pull-up 10kΩ ต่อไว้ให้แล้ว 

บล็อกไดอะแกรมส่วน I
2
C แสดงดังรูปที่ 19 

 

รูปที่ 19 บล็อกไดอะแกรมส่วน I2C 

ช่อง RS485 

ช่อง RS485 ประกอบด้วย A+ และ B- ใช้ต่อกับเซ็นเซอร์ RS485 หรือ Modbus RTU เช่น 

เซ็นเซอร์วัดความช้ืนในดิน เซ็นเซอร์อุณหภูมิ เซ็นเซอร์วัดระดับน้ำฝน เซ็นเซอร์วัดความเร็วลม เป็นต้น 

ช่อง RS485 บนบอร์ดมี Resistor Termination ค่าความต้านทาน 120Ω มาให ้แล้ว พร้อม TVS 

ป้องกันแรงดันไฟฟ้าในบัสสูงเกินกำหนด 

 

รูปที่ 20 ส่วนประกอบภาค RS485 
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ตัวอย่างการต่อเซ็นเซอร์วัดอุณหภูมิและความช้ืน XY-MD02 เข้ากับช่อง RS485 แสดงดังรูปที่ 21 

 

รูปที่ 21 การต่อเซ็นเซอร์วัดอุณหภมูิและความช้ืน XY-MD02 เข้ากับ Fame1 

ช่อง RS485 ต่อกับ ESP32 ผ่านวงจรแปลง RS485 เป็น UART เข้าที่ขา 4 (RX), 15 (TX) และ 2 

(DIR) บล็อกไดอะแกรมส่วน RS485 แสดงดังรูปที่ 22 

 

รูปที่ 22 บล็อกไดอะแกรมส่วน RS485 

วงจรนับเวลา (RTC) 

วงจรนับเวลาต่อตรงกับ ESP32 ผ่านช่อง I
2
C ใช้นับเวลาเมื่อไม่มีอินเตอร์เน็ต หรือเมื่อไม่มีไฟเล้ียง 

ใช้ประกอบการเขียนโปรแกรมที่ต้องการให้ทำงานตามเวลา เช่น ส่งค่าที่วัดได้ในฟาร์มขึ้นระบบคลาวด์ตาม

เวลา เปิด-ปิดไฟตามเวลา เปิด-ปิดปั้มน้ำตามเวลา เป็นต้น 

วงจรนับเวลา (RTC) จำเป็นต้องใช้ถ่าน CR2032 จ่ายไฟเล้ียงให้วงจร โดยไฟจากถ่านจะถูกใช้เมื่อ

ไม่มีแรงดันจากแหล่งจ่ายไฟจ่ายเข้ามา ทำให้วงจรส่วนนับเวลา (RTC) ยังมีไฟเล้ียงอยู่ตลอด ทำให้วงจรยัง
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ทำงาน นับเวลาอยู่เร่ือย ๆ จดจำค่าเวลาได้ และพร้อมให้เรียกใช้ค่าเวลาเมื่อวงจรส่วนประมวลผลกลับมา

ทำงานอีกคร้ัง 

 

รูปที่ 23 ส่วนประกอบวงจรนับเวลา (RTC) 

บล็อกไดอะแกรมส่วนวงจรนับเวลา (RTC) แสดงดังรูปที่ 24 

 

รูปที่ 24 บล็อกไดอะแกรมส่วนวงจรนับเวลา (RTC) 
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การเขียนโปรแกรมส่ังงานด้วย Arduino IDE 

Farm1 ใช้ไมโครคอนโทรลเลอร์ ESP32 ในการประมวลผล รองรับเคร่ืองมือพัฒนาทั้ง ESP-IDF 

และ Arduino IDE ในเอกสารนี้จะแนะนำตัวอย่างการเขียนโปรแกรมแต่ละส่วนด้วย Arduino IDE 

ติดต้ังโปรแกรม Arduino IDE 

โปรแกรม Arduino IDE เป็นหนึ่งในเครื่องมือที่ใช้พัฒนาโปรแกรมให้ Farm1 ซึ่งประกอบไปดว้ย 

Text Editor ใช้แก้ไขโค้ดโปรแกรม, Compiler และ Uploader 

ขั้นตอนการติดตั้งโปรแกรม Arduino IDE มีดังนี้ 

เข้าไปที่ http://www.arduino.cc/en/Main/Software เลือก OS ใหต้รงกับเคร่ืองคอมพิวเตอร์  

 

กดปุ่ม JUST DOWNLOAD เพ่ือเร่ิมดาว์โหลดโปรแกรม 

 

รอจนกว่าการดาว์โหลดจะเสร็จสิ้น แล้วจึงทำขั้นตอนถัดไป 

 

http://www.arduino.cc/en/Main/Software
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เมื่อดาว์โหลดเสร็จแล้วให้เปิดไฟล์ติดตั้งขึ้นมา แล้วกดปุ่ม I Agree เพ่ือยืนยันยอมรับเง่ือนไขการใช้งาน

โปรแกรม 

 

คลิกปุ่ม Next > เพ่ือติดตั้งทั้งหมด 

 

เลือกโฟลเดอร์ติดตั้งโปรแกรม หากไมต่้องการแก้ไขคลิกปุ่ม Install 

 

  



  กล่องควบคุมฟาร์มระบบ IoT 

  หน้าที่ 32 

รอจนกว่าโปรแกรมจะติดตั้งเสร็จสิ้น 

 

เมื่อขึ้นคำว่า Completed ให้กดปุม่ Close เพ่ือปิดหนา้ต่างติดตั้งโปรแกรมได้เลย 

 

หน้าเดสท็อปก็จะมไีอคอ่นโปรแกรม Arduino ขึ้นมาแล้ว 

 

ติดต้ังไดร์เวอร์ FT231X 

บอร์ด IOXESP32+ เป็นบอร์ดที่ใช้พัฒนา ESP32 เสียบอยู่บน Farm1 มีวงจรอัพโหลดโปรแกรมบน

บอร์ดผ่านชิปแปลง USB เป็น UART เบอร์ FT231X ซึ่งจำเป็นต้องติดตั้งไดร์เวอร์ก่อนจึงจะอัพโหลด

โปรแกรมเข้าได้ 
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เข ้าไปที ่ https://ftdichip.com/drivers/vcp-drivers/ กดดาวน์โหลดไฟล์ตาม OS ของเครื ่อง

คอมพิวเตอร์ 

 

จะได ้ ไฟล ์มา CDM vxxxxx WHQL Certified.zip  ให ้แตกไฟล์ด้วยโปรแกรม  WinRAR, 7-Zip

 

เข้าไปในโฟลเดอร์ที่แตกไฟล์มา แล้วคลิกขวาที่ไฟล์ ftdiport.inf กด Install 

  

https://ftdichip.com/drivers/vcp-drivers/
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จากนั้นหน้าต่างให้ยืนยันจะแสดงขึ้นมา ให้กดปุ่ม Yes หากติดตั้งสำเร็จ จะมีข้อความแจ้ง (ดังรูป) 

 

เปิด Device Manager ขึ้นมา โดยพิมพ์ในช่องค้นหา 

 

เสียบสาย USB ตามหัวข้อ การเชื่อมต่อ Farm1 เข้ากับเครื่องคอมพิวเตอร์ จากนั้นสังเกตในหน้าตา่ง 

Device Manager จะต้องมีหัวข้อ Ports และมี USB Serial Port ขึ้น เป็นอันเสร็จสิ้นการติดตั้งไดร์เวอร์ 
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การเพ่ิมบอร์ด ESP32 ลงโปรแกรม Arduino IDE 

โปรแกรม Arduino IDE เดิมรองรับการเขียนโปรแกรมสั่งงานเฉพาะบอร์ดที่ผลิตโดย Arduino 

เท่านั้น หากต้องการใช้เขียนโปรแกรมให้ ESP32 จำเป็นต้องติดตั้งบอร์ด ESP32 เพิ่ม โดยติดตั้ง 

Arduino core for the ESP32 

เปิดโปรแกรม ArduinoIDE ขึ้นมา โดยดับเบิลคลิกที่ไอค่อน Arduino บนหน้าเดสท็อป กด File เลือก 

Preferences 

 

ในช่อง Additional Boards Manager URLs ใส่  

https: / / raw. githubusercontent. com/ espressif/ arduino- esp32/ gh-

pages/package_esp32_index.json 

แล้วกดปุ่ม OK (ในรูปเป็นล้ิงเก่า ให้ใส่ล้ิงใหม่ด้านบน) 
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จากนั้นกด Tools > Board เลือก Boards Manager... 

 

จากนั้นกด Type เลือก Contributed 

 

เล่ือนหา esp32 แล้วกดปุ่ม Install 

 

เมื่อติดตั้งเสร็จแล้ว จะแสดงคำว่า INSTALLED กดปุ่ม Close เพ่ือปิดหน้าต่าง เป็นอันเสร็จสิ้นการเพ่ิม

บอร์ด ESP32 ลงโปรแกรม Arduino IDE 
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การเชื่อมต่อ Farm1 เข้ากับเคร่ืองคอมพิวเตอร์ 

ใช้สาย USB-C เสียบช่อง USB-C บนบอร์ด IOXESP32+ ปลายอีกด้านของสายเสียบเข้ากับ

เคร่ืองคอมพิวเตอร์ 

◼ สาย USB-C หาซ้ือได้ทั่วไปตามร้านขายอุปกรณ์ IT, ร้านโทรศัพท์, ร้านสะดวกซ้ือ, ห้างสรรพสินค้า 

 

รูปที่ 24 การเช่ือมตอ่ Farm1 เขา้กับเคร่ืองคอมพิวเตอร์ด้วยสาย USB-C 

ทดสอบอัพโหลดโปรแกรมไฟกระพริบ 

ที่โปรแกรม Arduino IDE กดไปที่ File > Examples > 01.Basics เลือก Blink 
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แก้ไข LED_BUILIN ให้เป็น 25 (ขา O1) 

 

เลือกบอร์ดให้ถูกต้อง โดยกด Tool > Board > ESP32 Arduino เลือกบอร์ด ESP32 Dev Module 
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เลือกพอร์ตให้ถูกต้อง โดยกดไปที่ Tool > Port เลือก COM... ที่มีให้เลือก  

◼ หากไม่ขึ ้นพอร์ตให้เลือก ให้ตรวจสอบสาย USB-C ว่าเสียบแน่นแล้วหรือยัง โดยสังเกตบอร์ด 

IOXESP32+ ไฟ PWR สีเขียวต้องติดสว่าง หากคาดว่าบอร์ดทำงานปกติ ให้ตรวจสอบการติดตั้งไดร์

เวอร์ FT231Xอีกคร้ัง 

 

กดปุ่ม  เพ่ือคอมไพล์และอัพโหลดโปรแกรมลงบอร์ด (เวลาที่ใช้ในการคอมไพล์และอัพโหลดอาจถึง 2 

นาที หากไม่มีข้อความแจ้ง Error หรือ Done uploading ให้รอก่อน) 

 

หากคอมไพล์และอัพโหลดโปรแกรมสำเร็จ จะมีข้อความ Done uploading แสดงขึ้นมา (ดังรูป) 

 

ผลลัพธ์ที่ได้ ไฟที่ช่อง O1 จะกระพริบทุก ๆ 1 วินาที พร้อมมีเสียงรีเลย์ตัด-ต่อ 
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เขียนโปรแกรมส่ังงานช่องเอาต์พุต 

ใช้คำสั่ง pinMode() และ digitalWrite() ในการเขียนโปรแกรมสั่งงานช่องเอาต์พุต 

กำหนดแทนที่ O1_PIN, ..., O4_PIN ด้วยหมายเลขขาที่ต่อกับ ESP32 ดังนี้ 

1. #define O1_PIN 25 
2. #define O2_PIN 14 
3. #define O3_PIN 12 
4. #define O4_PIN 13 

 ใน void setup() ใช้สั่ง pinMode() กำหนดขา O1 ถึง O4 เป็นเอาต์พุต 

1. void setup() { 
2.   pinMode(O1_PIN, OUTPUT); 
3.   pinMode(O2_PIN, OUTPUT); 
4.   pinMode(O3_PIN, OUTPUT); 
5.   pinMode(O4_PIN, OUTPUT); 
6. } 

ใน void loop() ใช้คำสั่ง digitalWrite() สั่งให้รีเลย์ช่อง O1 ตัด-ต่อทุก ๆ 1 นาที  

1. void loop() { 
2.   digitalWrite(O1_PIN, HIGH); 
3.   delay(1000); 
4.   digitalWrite(O1_PIN, LOW); 
5.   delay(1000); 
6. } 

ได้โค้ดโปรแกรมที่สมบูรณ์ดังนี้ 

1. #define O1_PIN 25 
2. #define O2_PIN 14 
3. #define O3_PIN 12 
4. #define O4_PIN 13 
5.   
6. void setup() { 
7.   pinMode(O1_PIN, OUTPUT); 
8.   pinMode(O2_PIN, OUTPUT); 
9.   pinMode(O3_PIN, OUTPUT); 
10.   pinMode(O4_PIN, OUTPUT); 
11. } 
12.   
13. void loop() { 
14.   digitalWrite(O1_PIN, HIGH); 
15.   delay(1000); 
16.   digitalWrite(O1_PIN, LOW); 
17.   delay(1000); 
18. } 
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อัพโหลดโปรแกรมลงบอร์ด จะได้ยินเสียงรีเลย์ตัด-ต่อ และไฟช่องเอาต์พุตติด-ดับ ทุก ๆ 2 วินาที 

เขียนโปรแกรมอ่านช่องอินพุตดิจิทัล 

ใช้คำสั่ง pinMode() และ digitalRead() ในการอ่านค่าช่องอินพุตดิจิทัล 

กำหนดแทนที่ O1_PIN, ..., O4_PIN และ D1_PIN, D2_PIN ด้วยหมายเลขขาที่ต่อกับ ESP32 ดังนี้ 

1. #define O1_PIN 25 
2. #define O2_PIN 14 
3. #define O3_PIN 12 
4. #define O4_PIN 13 
5.   
6. #define D1_PIN 34 
7. #define D2_PIN 34 

ใน void setup() ใช้สั่ง pinMode() กำหนดขา O1 ถึง O4 เป็นเอาต์พุต และกำหนดขา D1 และ D4 เป็น

อินพุตดิจิทัล 

1. void setup() { 
2.   pinMode(O1_PIN, OUTPUT); 
3.   pinMode(O2_PIN, OUTPUT); 
4.   pinMode(O3_PIN, OUTPUT); 
5.   pinMode(O4_PIN, OUTPUT); 
6.    
7.   pinMode(D1_PIN, INPUT); 
8.   pinMode(D2_PIN, INPUT); 
9. } 

 ใน void loop() ใช้คำสั่ง digitalRead() อ่านค่าเก็บลงตัวแปร value ชนิด int  

1.    int value = digitalRead(D1_PIN); 

ใช้คำสั่ง if ตรวจสอบค่าในตัวแปร value หากได้ 0 ให้สั่งรีเลย์ช่อง O1 ทำงาน ใช้คำสั่ง else หากเง่ือนไข

ใน if ไม่เป็นจริง ให้รีเลย์ช่อง O1 หยุดทำงาน 

2.    if (value == 0) { 
3.     digitalWrite(O1_PIN, HIGH); 
4.   } else { 
5.     digitalWrite(O1_PIN, LOW); 
6.   } 
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ได้โค้ดโปรแกรมที่สมบูรณ์ดังนี้ (ดาวน์โหลดโค้ดโปรแกรมได้ที่ ) 

1. #define O1_PIN 25 
2. #define O2_PIN 14 
3. #define O3_PIN 12 
4. #define O4_PIN 13 
5.   
6. #define D1_PIN 34 
7. #define D2_PIN 34 
8.   
9. void setup() { 
10.   pinMode(O1_PIN, OUTPUT); 
11.   pinMode(O2_PIN, OUTPUT); 
12.   pinMode(O3_PIN, OUTPUT); 
13.   pinMode(O4_PIN, OUTPUT); 
14.    
15.   pinMode(D1_PIN, INPUT); 
16.   pinMode(D2_PIN, INPUT); 
17. } 
18.   
19. void loop() { 
20.   int value = digitalRead(D1_PIN); 
21.   if (value == 0) { 
22.     digitalWrite(O1_PIN, HIGH); 
23.   } else { 
24.     digitalWrite(O1_PIN, LOW); 
25.   } 
26.   delay(10); 
27. } 

อัพโหลดโปรแกรมลงบอร์ด ที่ช่อง D1 ด้านนึงต่อเข้ากับ GND อีกด้านใช้สายลอย (ดังรูปที่ ...) แตะกับ 

5V หรือ VIN สังเกตไฟสีส้มของช่อง D1 จะติดเมื่อแตะโดน และจะดับเมื่อนำออก ส่วนรีเลย์ช่อง O1 จะ

ทำงานเมื่อแตะสายไฟ และหยุดทำงานเมื่อนำสายไฟออก 

เขียนโปรแกรมอ่านชอ่งอินพุตแอนะล็อก 

ใช้คำสั่ง analogRead() อ่านค่าช่องอินพุตแอนะล็อก ได้ค่า 0 ถึง 4095 เมื่อ 4095 เทียบได้กับแรงดัน 

9.9V (ตามวงจรในหัวข้อ ช่องอินพุตแอนะล็อก) 

กำหนดแทนที่ A1 และ A2 ด้วย 36 และ 39 ตามลำดับ 

1. #define A1_PIN 36 
2. #define A2_PIN 39 
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ใน void loop() ใช้คำสั่ง analogRead() อ่านค่าแอนะล็อกจาก A0 แล้วนำค่าที่ได้เทียบัญญัติไตรยางค์

เพ่ือแปลงเป็นแรงดัน เก็บลงตัวแปร volt ชนิด float 

1.   float volt = analogRead(A1_PIN) / 4095.0 * 9.9; 

 ใช้คำสั่ง Serial.println() ให้แสดงคา่ในตัวแปร volt ออกมาทาง Serial Monitor 

2.   Serial.println(volt); 

 ได้โค้ดโปรแกรมที่สมบูรณ์ดังนี้ 

3. #define A1_PIN 36 
4. #define A2_PIN 39 
5.   
6. void setup() { 
7.   Serial.begin(115200); 
8. } 
9.   
10. void loop() { 
11.   float volt = analogRead(A1_PIN) / 4095.0 * 9.9; 
12.   Serial.println(volt); 
13.   delay(10); 
14. } 

อัพโหลดโค้ดโปรแกรมลงบอร์ด เปิด Serial Monitor โดยกด  ตั้ง band เป็น 115200 แล้วทดลอง

จั้มระหว่าง A1 กับ 5V จากนั้นทดสอบจั้มระหว่าง A1 กับ 3.3V สังเกตผลที่ได้ใน Serial Monitor จะ

ต่างกัน 

◼ วงจรส่วนแอนะล็อกใช้ไฟจาก VIN จึงจำเป็นต้องต่อไฟเข้า VIN เพ่ือให้วงจรแอนะล็อกทำงานได้ถูกต้อง 
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เขียนโปรแกรมช่อง I/O อ่านค่าอุณหภูมิจาก DS18B20 

ต่อวงจรตามหัวข้อ ช่อง I/O ติดตั้งไลบาร่ี OneWire ตามขัน้ตอนดังนี ้

เข้าไปที่ https://github.com/PaulStoffregen/OneWire กด Code แล้วกด Download ZIP  

 

จะได้ไฟล์ OneWire-master.zip มา 

 

ที่โปรแกรม Arduino IDE กด Sketch > Include Library เลือก Add .ZIP Library 

 

เลือกไฟล์ OneWire-master.zip ที่ดาวน์โหลดมา กดปุ่ม Open 

 

https://github.com/PaulStoffregen/OneWire
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หากติดตั้งสำเร็จ จะมีข้อความ Library added ขึ้น (ดังรูป) 

 

ติดตั้งไลบาร่ี DallasTemperature ด้วย Library Manager ตามขั้นตอนดังนี้ 

กด Sketch > Include Library เลือก Manage Libraries 

  

หน้าต่าง Library Manager จะแสดงขึ้นมา ให้ค้นหา DallasTemperature แล้วเลือกกดปุ่ม Install 

ไลบาร่ี by Miles Burton 
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เมื่อติดตั้งเสร็จแล้ว จะมีข้อความ INSTALLED แสดง (ดังรูป) กดปุ่ม Close เพ่ือปิดได้เลย 

 

ดาวน์โหลดโปรแกรมตัวอย่างจาก https://bit.ly/3HkpJx5 อัพโหลดโปรแกรมลงบอร์ด แล้วเปิด 

Serial Monitor ขึ้นมา โดยกด  

 

เลือก 115200 band หากต่อวงจรถูกต้อง เซ็นเซอร์ทำงานได้ จะมีอุณหภูมิในหน่วยองศาเซลเซียส และ

องศาฟาเรนไฮต์แสดงขึ้นมา 

 

https://bit.ly/3HkpJx5
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เขียนโปรแกรมช่อง I
2
C อ่านค่าอุณหภูมิและความชื้นจาก SHT30 

ต่อวงจรตามหัวข้อ ช่อง I2C ติดตั้งไลบาร่ี ClosedCube SHT31D ด้วย Library Manager จากนั้นเปิด

โค้ดโปรแกรมตัวอย่าง periodicmode ขึ้นมา 

 

อัพโหลดโปรแกรมลงบอร์ด เป ิด Serial Monitor ขึ ้นมา ปรับ band เป ็น 9600 ค่าอ ุณหภูมิและ

ความช้ืนที่ SHT30 วัดได้จะแสดงขึ้นมา 

◼ หากมีข้อความ Periodic Mode: [ERROR] ให้แก้ไขหมายเลขของอุปกรณ์บรรทัดที่ 32 จาก 0x44 

เป็น 0x45 อัพโหลดโปรแกรมแล้วดูผลอีกคร้ัง 
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เขียนโปรแกรมช่อง RS485 อ่านค่าอุณหภูมิและความชื้นจาก XY-MD02 

ต่อวงจรตามหัวข้อ ช่อง RS485 ติดตั้งไลบาร่ี ModbusMaster ด้วย Library Manager จากนั้นดาวน์

โหลดโค้ดตัวอย่างจาก https://bit.ly/3ccUxRV แก้ไขหมายเลขอุปกรณ์ (Device ID) ของ XY-

MD02 ให้ถูกต้อง (ค่าจากโรงงาน เป็น ID: 1) อัพโหลดโปรแกรมลงบอร์ด 

 

เปิด Serial Monitor ขึ้นมา ปรับ Band เป็น 115200 หากต่อวงจรถูกตอ้ง เซ็นเซอร์ทำงานได้ คา่

อุณหภมูิและความช้ืนที่วัดได้จะแสดงขึ้นมา 

 

  

https://bit.ly/3ccUxRV
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เขียนโปรแกรมต้ังเวลาและอ่านค่าเวลาจากวงจรนับเวลา (RTC) 

ติดตั้งไลบาร่ี Artron DS1338 ด้วย Library Manager เปิดตัวอยา่งโค้ดจากเมนู File > Examples > 

Artron DS1338 > DS1338_set_get_datetime 

 

อัพโหลดโปรแกรมตัวอย่างลงบอร์ด เปิด Serial Monitor ปรับ 115200 band  ผลที่ได้คือ เวลาใน RTC 

จะถูกตั้ง และแสดงเวลาที่นับขึ้นเรื่อย ๆ บน Serial Monitor 

 

คำแนะนำการติดตัง้ 

อุปกรณ์รองรับการติดตั้งบนรางปีกนก ไม่กันน้ำ การใช้งานจริงจึงควรติดตั้งบนรางปีกนกในกล่อง

กันน้ำ รูร้อยสายใฟที่เข้ากล่องควรใช้คอนดนคเตอร์แบบกันน้ำ หรือใช้เคเบิ้ลแกลนด์ เพ่ือป้องกันน้ำเข้า

ภายในกล่อง ควรรักษาอุณหภูมิให้ไม่เกิน 80 องศาเซลเซียส ซ่ึงอาจทำให้อุปกรณ์อิเล็กทรอนิกส์

เสียหาย การเก็บรักษาควรเก็บในที่แห้ง ไม่โดนแดดโดยตรง 
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พาวเวอร์ซัพพลายควรเลือกใช้รุ ่นที่สามารถทนไฟกระชากได้ มีระบบตัดไฟเมื่อกระแสเกิน มี

อุปกรณ์ป้องกันฟ้าผ่า โดยอาจสังเกตและเลือกใช้พาวเวอร์ซัพพลายที่มีสัญลักษณ์ CE หรือ มอก. 

พร้อมติดตั้งเบรกเกอร์เพ่ือใช้ปิดอุปกรณ์เมื่อต้องบำรุงรักษา 

แนวทางการแกไ้ขปัญหา 

ปัญหา แนวทางแก้ไข 

ปัญหาเอาต์พุต 

ใช้คำสั่ง digitalWrite() แต่รีเลยไ์ม่ทำงาน ไฟ

เอาต์พุตไม่ติด 

เป็นได้ทั้งปญัหาซอฟแวร์และปัญหาด้านฮาร์ดแวร์ 

• อาจลืมใช้คำสั่ง pinMode() หรือใช้ไม่

ถูกต้อง กอ่นเรียกใช้ digitalWrite() 

• ใช้คำสั่ง digitalWrite() ผิดขา 

• ESP32 รีเซ็ตก่อนทำงานถึงคำสั่ง 

digitalWrite() (ให้เปิด Serial Monitor 

ขึ้นมาดู) 

• บอร์ด IOXESP32+ หลวม ทำให้ไฟฟ้า

ไม่สามารถไหลได ้

• กระแสไฟฟ้าจากแหล่งจ่ายไม่เพียงพอให้

อุปกรณ์ทำงานได้ปกต ิ

ไฟติด-ดับ แต่ไม่มีเสยีงรีเลย์ตัด-ตอ่ • รีเลย์เสีย 

ปัญหาอินพุตดิจิทัล 

ใช้คำสั่ง digitalRead() ได้คา่เป็น 1 หรือเป็น 0 

ตลอดเวลา 

• ให้สังเกตไฟตรงจุดเอาต์พุต หากต่อวงจร

ให้ต้องเป็น 1/0 แตไ่ฟไม่ติด-ไม่ดับ เป็น

ปัญหาด้านฮาร์ดแวร์หรือระบบไฟฟ้า ให้

ใช้มัลติมิเตอร์ตรวจสอบแรงดันแต่ละจุด  

• หากไฟติด-ดับปกติ ให้ตรวจสอบโค้ด

โปรแกรมว่าอ่านออกมาถูกขา 

• ตรวจสอบว่าใช้คำสั่ง pinMode() ก่อน

ใช้คำสั่ง digitalRead() แล้ว 
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ปัญหาอินพุตแอนะล็อก 

วัดแรงดันได้สูงสุด 2V กว่า ๆ แม้จะป้อนแรงดัน

มากกว่านี ้

เกิดจากไม่ได้จ่ายไฟเข้า VIN 7V ถึง 12V วงจร

อินพุตแอนะล็อกใช้ไฟจาก VIN ในการทำงาน หาก

ไม่จ่ายไฟ ค่าที่วัดได้จะไม่ถูกตอ้ง 

วัดแรงดันได้ไม่ตรง เป็นปัญหาในระดับชิป ให้ใช้ไลบาร่ี 

ESP32AnalogRead อา่นแรงดันแทน จะใหค้่าที่

ตรงความเป็นจริงมากขึ้น 

ช่อง I
2
C 

ติดต่อกับอุปกรณ ์I
2
C ไม่ได ้ สังเกตไฟช่อง I

2
C ว่ากระพริบหรือไม ่หาก

กระพริบแสดงว่ามีการส่งข้อมูลออกจากบอร์ด

แล้ว แต่อุปกรณ์ปลายทางอาจไม่ได้รับ หรือไม่

ทำงาน หากไฟไม่กระพริบ แสดงว่าไมม่ีข้อมูล

ส่งออกจากบอร์ด ให้ตรวจสอบโค้ดโปรแกรม 

ช่อง RS485 

ติดต่อกับอุปกรณ ์RS485 ไม่ได ้ สังเกตไฟช่อง RS485 ตรง TX ว่ากระพริบ

หรือไม ่หากกระพริบแสดงว่ามีการส่งข้อมูลออก

จากบอร์ดแล้ว จากนั้นให้สังเกตไฟ RX ว่าทำงาน

อย่างไร 

• ไฟ RX กระพริบ แสดงว่าอุปกรณ์

ปลายทางส่งข้อมูลเขา้มาแล้ว แต่ฝ่ัง 

Farm1 รับขอ้มูลไม่ได้ ใหต้รวจสอบโค้ด

โปรแกรม 

• ไฟ RX ไม่กระพริบ แสดงว่าอปุกรณ์

ปลายทางไม่ตอบสนอง อาจเป็นไปได้ว่า

หมายเลข ID ของอุปกรณ์ที่ร้องขอข้อมูล

ไม่มีอยู่ หรือ ID ของอุปกรณ์ผิด ให้ใช้

โปรแกรม CAS Modbus Scanner ลอง

สแกนหา ID ดูกอ่น รวมทั้งอาจ

ตรวจสอบการตั้งคา่ Band Rate และ 
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Prarity ด้วย ว่าตั้งคา่ไว้ตรงกับที่

อุปกรณ์ตอ้งการหรือไม ่

หากไฟ TX ไม่กระพริบ 

• ยังส่งข้อมูลออกไมไ่ด้ ให้ตรวจสอบโค้ด

โปรแกรม 

ปัญหาวงจรนับเวลา 

เวลาไม่ถูกต้องหลังตัดไฟ ไม่ได้ใส่แบตเตอร่ี หรือแบตเตอร่ีหมด 
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บริษัท อาร์ทรอน ชอป จำกัด รับพัฒนาสินค้าอิเล็กทรอนิกส์ บอร์ดอิเล็กทรอนิกส์ ด้านระบบ IoT 

พัฒนาเว็บไซต์ระบบ IoT ด้วย ReactJS / Next.js รับทำระบบหลังบ้านให้อุปกรณ์ IoT รับเขียนเฟิร์ม

แ ว ร ์ อ ุ ป ก รณ ์  IoT ด ้ ว ย  Arduino IDE /  PlatformIO /  Atmel Studio /  MPLAB IDE / 

STM32CubeIDE / IAR / ESP-IDF / Arm Keil รับจัดหาชิ้นส่วนอิเล็กทรอนิกส์ ออกใบเสนอราคา 

และใบกำกับภาษีได้ 

ติดต่อสอบถามข้อมูลเพิ่มเติม 

• เว็บไซต์ www.artronshop.co.th 

• โทร: 02 003 3688 (สำนักงาน) 

• อีเมล: contact@atronshop.co.th 

• LINE: @artronshop 

• Facebook: ArtronShop 

• Youtube: ArtronShop 

 

 

https://www.artronshop.co.th/
https://www.facebook.com/artronshop
https://www.youtube.com/channel/UCPZZ_UUolU4dss5KJaoQPgQ
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